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Introducing Bartco VMS Web Studio® 

BARTCO VMS WEB STUDIO® is a web-based application that runs on BARTCO's secure cloud network 
for maximum security and high availability. It has been developed to allow customers to interact and 
provide full management of their BARTCO products, including Variable Message Signs (VMS), 
Variable Speed Limit Signs (VSLS), Electronic Fire Danger Rating signs, Electronic Snow / Wheel Chain 
Rating signs and Portable Traffic Signals, etc. 
 
VMS WEB STUDIO® is a real-time internet-based communication facility enabling live communication 
via cellular or satellite networks from any internet enabled PC, laptop, tablet or mobile, eliminating 
the need for the installation of local software. 
 
Features include: 

• Fully web based allowing remote programming from any internet enabled PC / Laptop / 
Tablet or mobile. 

• Secure login 

• Asset Management and tracking system 

• Create and manage customers (perfect for hire/rental companies) 

• Quick and easy operation 

• Clean user-friendly interface 

• Asset grouping 

• Program multiple assets instantly 
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1. Logging In 

From the browser address bar go to the VMS Web Studio web page: www.vmsstudio.com 

 
Enter your username and password as received in your email.  
 
Notes: 

- If you have not been allocated a username and password, please contact Bartco to receive a 
user access form. 

- Contact Bartco to delete a user from Web Studio 
- Bartco suggests using Google Chrome as the best compatible browser with Web Studio. 

Google Chrome can be downloaded at the link: http://www.google.com/chrome 

 

 
  
 

  

http://www.vmsstudio.com/
http://www.google.com/chrome
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2. Web Studio Main Page Orientation 

 
 
 
 
 
  

 
 

 

 

 

 

 

 
  

Details on asset’s status 
like battery, active file, 

luminance, etc. 

Information panel: 
displays result of an 

action on asset 

Real time 
asset’s location 

on map 

Feature / Tool tabs: 
Each tab represents a 

different operational feature 

Asset list: List of all 
assets that user 
has access to.  

 

Dashboard 
provides helpful 

insights on assets 
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3. Assets, Groups and Job Queue 

 

3.1 Assets 

All the assets are displayed in the Assets List. 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

Bartco board 

Asset icon: type 
of the asset 

Asset name 

User defined 
Group name 

 

Select all assets, select 
none, invert selection 

Total number 
of assets in list 

Various filters 
applied to assets 

Status icons: legends 
(described below) 

 

 

Filter assets by name, 
type, group, etc. 

Search asset by 
name, serial number, 

etc. 

Number of 
selected assets 
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3.1.1 Asset’s icon and status icons 

Asset’s icon represents type of the asset: 
 

 
5 Colour A Size 

 
Amber A Size 

 
5 Colour B Size 

 
Amber B Size 

 
5 Colour C Size 

 
 

Amber C Size 

 
Portable Traffic Light - Master 

 
Fire Sign 4 Ratings 

 
Portable Traffic Light – Slave 

 
 

Retrofitted Fire Sign 

 
VSLS (Variable Speed Limit Sign) 

  
HDA sign               

 
Half Size - Speed Sign 

 
HDC sign 

  
 

Wide Size Sign 

 
Asset shows several status icons to denote various state of an asset as described below: 

  
 represents Bartco board 

 
 

 

 Status older than 24 hours  Locked by Web Studio 

 Asset has communicated in last 24 hours 
and has warning 

 Automatic programming enabled 

 Asset has communicated in last 24 hours  Automatic programming disabled 

 Asset has no status   

    

 Battery Low (warning)  Radar enabled 

 Battery OK  Radar disabled 

 Battery Good   

    

 Low signal strength (warning)  Locked by Road Authority 

 Weak signal strength  Not locked by Road Authority 

 Strong signal strength   

    

 Firmware critically out of date (warning)  Asset is currently on hire 

 New firmware available to upgrade  Asset is hired and hire duration is inactive 

 Firmware upgrade is in progress  Asset is available to hire 

 Latest firmware installed  No permission to hire asset 

    

 2G controller  Hired asset access until DD MMM YYYY 

 3G controller   

 4G controller  Upgrade to Web Studio 
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3.1.2 Filters 

Filter assets by Alert, Controller Config, asset type, etc. 
 
Assets by Alert menu shows below alerts: 
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Controller Config menu shows below options: 

 
 
 
 
Various filters can be applied simultaneously to the assets list. 

For example, filter all assets that are currently on hire   and has low battery : 
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3.1.3 Quick options menu 

Right click on selected asset in the Assets list to display quick options menu. 
Note: this menu changes based on asset’s type. 
 
The following is an example of quick options menu on VMS: 

  
 

 
i. Update status 

Manually update the status of asset 
 

ii. Blank sign 
Blank the display of asset 
 

iii. Wake sign 
Start displaying last message on the asset 
 

iv. Sleep sign 
Put asset in sleep mode 
 

v. Program History 
Show history of messages programmed on the asset 

 
 

vi. Upgrade Firmware 
This option is only available if the user has permission to upgrade firmware on asset 
Go to 16.2.2 Upgrade Firmware section for more information. 
 
 
 
 
 
 
 

Upgrade Firmware 
requires user permission 
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3.2 Groups 

Very useful if you have multiple assets in your account. Assets can be grouped by one project, area, 
or section of roadway using user defined group name. 
 

 
 
 
Selecting a group will list all the assets in that group: 
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➢ Group an asset using Asset Info: 

i. Select asset from Assets list 
 

ii. Go to Asset Info 
 

iii. Update value of the “Group” field 
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➢ Group an asset using Groups/Filter: 

i. Select asset from Assets list 

ii. Select  

 
 

iii. Select “Move to” or “Move to new Group” option from Selected Assets menu 

 
 

 

 

3.3 Job Queue 

Upload file, updating status, etc. tasks are added in the Job Queue. When the job is completed 
successfully, it will be removed from the Job Queue. If there is an error in completing the job, then 
the error is displayed in the Job Queue. 
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4. Asset Information 

Click on an asset to see its detailed status. 
 

  
 

  

Active File: Displays 
last known 

status/message of the 
selected asset. 

Asset’s last known 
status, radar status 

and asset’s info 
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4.1 Asset Status 

The fields in the status changes based on the asset type. The below is an example of VMS: 
 

 
 
 

Date Last date when asset communicated with Web Studio 

Time Last time when asset communicated with Web Studio 
(+10:00) shows the timezone of the asset 
(+11:00 DST) is displayed when Daylight Savings Time is applied 

Firmware version Firmware version of the asset 

Serial number Serial number of the asset 

Active File Asset is currently displaying this file 

Active Status State of the asset 

Battery voltage Battery of the asset 

Temperature Temperature of the controller in centigrade 

Cooling Fans Cooling fans are active or inactive 

LED Output Brightness of the display in percentage 

Luminance Shows level of luminance and Auto or Manual mode 

Trip Wire Tamper Alarm loop 
The name of this field can be set using “Input 1 Label” in Asset Info. 
Default value is “Trip Wire” 

Radar Radar is enabled/disabled on the asset 

GPS Lat GPS latitude of the asset  
If GPS is lost then asset is shown at last known location on Mapping 
tab and Asset’s status icon shows as warning 
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GPS Long GPS longitude of the asset 
If GPS is lost then asset is shown at last known location on Mapping 
tab and Asset’s status icon shows as warning 

Global ON:OFF Time Global time to switch the display on/off 

Signal Strength Signal strength of the asset 

Files List of files stored on the asset 

 

4.2 Radar Status 

Radar Status is only available when Radar is enabled on an asset 
 

 
 

Radar Options Radar setup to display detected speed only or interrupt displayed 
message 

Min Display Speed Minimum detection / display speed 

Posted Speed Zone Posted Speed Zone 

Max Display Speed Maximum detection / display speed 

(1) Msg Display First message displayed when vehicle is detected 

(1) Msg Display Time Duration (in sections) for which first message is displayed 

(2) Msg Display Second message displayed when vehicle is detected 

(2) Msg Display Time Duration (in sections) for which second message is displayed 

Log Options Logging enabled or disabled 

Log Min Speed Minimum speed for logging 

Current Speed Last speed detected by Radar 

Radar Log Settings List of email addresses to receive radar logs daily 
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4.3 Asset Info 

  
 

Company Owner company of the asset 

Asset ID Unique identified of the asset 

Model / Plant type Asset type 

Label Name of the asset (editable by user) 

Client Ref Another name of the asset (editable by user) 

Group Group of the asset (editable by user) 

Trailer VIN VIN number of the asset’s trailer 

Trailer Registration Rego number of the asset’s trailer 

Trailer Serial Serial number of the asset’s trailer 

Serial number Serial number of the asset 

Hardware Version Hardware version of the asset 

Firmware Version Firmware version of the asset 

Input 1 Label Label for Input 1 on the controller (editable by user) 

Radar Fitted Radar is fitted on the asset (editable by user) 

Special Features Any special characteristics of the asset, such as 4G 

Trailer Key Trailer key of the asset (editable by user) 

SIM PIN Sim card PIN number (if applicable) 

Value of these 
fields are editable 

by the user 
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4.3.1 Change label/name of asset 

To change the label/name of an asset: 
 

i. Select asset from Assets list 
ii. Go to Asset Info tab 

 
 

iii. Click on the value of Label field 

 
 

iv. Type new name and press Enter 
The new name will get updated immediately 
 

 
 
 

  

Click to edit label 
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5. Update Status 

To update the status of an asset: 
 

i. Select asset(s) from the Assets list 
 

ii. Right click on selected asset(s) 

 
 

iii. The user will be prompted as follows: 

 
  

iv. Click on OK to update status of the selected asset(s). The job will appear in Job Queue. 
Click on Cancel button to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 
 
Success:        Failed: 
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6. Mapping 

Bartco’s assets have inbuilt tracking system. This is used to display location of assets on maps. 
The location of the asset is the last known location of asset when it communicated with Web Studio. 

 

 

 

 
 
 

  

Double click on asset to 
get a close-up of the 

asset location 

Get directions to 
your asset from a 

given address 

Print map 
view 

Measure distance 
between points 



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 21 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

7. Create Message 

Creating a message is undertaken by selecting the “New File” tab from the main navigation page. 
This tab is also known as Drawing Area which creates Standard file. Once the message is prepared 
and saved under a name then that name will appear on the tab instead of new file/untitled. 
 

 

 

 

 

 

 
 

 

 

 

 

 

Draw or type your desired message in the drawing area. The drawing area is scaled to be the same 
size as the asset (VMS, Fire sign, etc.).  
 
The message can be typed in colour by selecting the required colour from the Drawing Tools. 

Different font sizes and line alignments are also available to choose. 

 
 

Multiple frames can be created. 
Use arrow buttons to navigate 

between frames 

Drawing area: type text or draw design 

This is visual representation of your 
asset’s display (VMS, Fire sign, etc.) 

Predefined images can 
be used directly on 

drawing area 

Upload 
standard 

file to asset 

Drawing tools like 
pen, eraser, colours, 

flashing, font size, etc. 
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Various functions on the frame can be performed using the below menu: 
 

 
 

 

 

 

 

 

 

Multiple frames can be created with different frame time. Use arrow buttons to navigate through 
the frames. 

 
 

Frame timing can start at 0.1 of a second to create animations. Length of message, asset position 
and target audience should all be considered when selecting frame times. 
 
 
 

7.1 Predefined Images 

Several predefined images are available like speeds, land closure, etc. which can be loaded directly 
onto the frame to prepare a message. 
 

➢ To load a predefined image: 

i. Select image from the predefined images list 
 

ii. Click on “Load >>” button 
Predefined image will be loaded in frame on the drawing area 

 

 
 

 

Preview 
of the 

file 

Manage frames 
and apply 
transitions 

Load image 
or save frame 
as an image 

Cut, copy, 
paste, etc. 
on frames 

Step i 

Step ii 

Apply or 
clear flashing 

on frame 

Invert 
colours 

on frame 

Apply 
setting to 
all frames 
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7.2 Message Transitions/Animations 

More commonly VMS are being used for advertising and promotions. Web Studio has the ability to 
create dynamic and animated messages to enhance the appeal of your message. 
 
To create a message transition or animation, simply create your message and then click on the 
Frame Organizer button from the menu. 
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➢ To apply transition/animation to your message: 

i. Click on desired frame to be animated in Frame Organizer 
 

ii. Select transition/animation from the dropdown 

 
 

iii. Select side 

 
 

iv. Set frames per second 
Note: higher the frame per second, lower the speed of the animation and more the number 
of frames in transition.  

 
v. Click on Apply button 

The selected frame will display the preview of the transition 
 

 

 
 

vi. After finishing applying transitions to desired frames, click on OK to save the changes and 
close the Frame Organizer 
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7.3 Preview 

Check the preview of the message to see how it will look on the VMS: 
 

 
 
Preview of the message: 
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8. Uploading file to asset 

Once the file has been prepared, it can either be saved or directly uploaded to the asset. To use 
messages in Radar and/or Schedule, it needs to be saved first. The message is saved in the cloud and 
is accessible to all the users of your company using their Web Studio account. 
 
 

8.1 Save File 

 
i. Go to File -> Save As 

 
 

ii. Enter filename and click on Save As button to save the file 
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8.2 Open File 

i. Go to File -> Open 

 
 

ii. Select file from the list and click on Open button 
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8.3 Upload saved file to asset 

i. After your file has been saved/opened, select asset(s) from the Asset list that you wish to 
upload the message to. 
Note: Multiple assets can be programmed simultaneously by holding down the shift or Ctrl 
key on your keyboard when selecting asset(s).  
 

ii. Click on Upload button   
The file that is open in the tab will be uploaded to the selected asset. 

 
iii. The user will be prompted as follows: 

 
 

iv. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:         Failed:  

    
 

Note: After you have uploaded your message, the active file will update with your current 
message and the overall asset status. 
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8.4 Upload file without saving 

Messages can be uploaded without saving them first.  
 

i. After your desired message is prepared, select asset from the Asset list that you wish to 
upload the message to. 
Note: Multiple assets can be programmed simultaneously by holding down the shift or Ctrl 
key on your keyboard when selecting asset(s).  
 

ii. Click on Upload button  
The message will be automatically saved into your __Unsaved_Files folder. 
Notes: 

- Files in this folder can be opened and resaved into another folder. 
- Files cannot be manually saved into this folder. 
- Files cannot be moved in or out of this folder with the File Manager. 

 
iii. The user will be prompted as follows to remind that an unsaved file is being uploaded: 

 

 
 

iv. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:         Failed:  

    
 

Note: After you have uploaded your message, the active file will update with your current 
message and the overall asset status. 
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9. Quick Speed 

Quick speed is designed to quickly change speed limits on VMS or VSLS assets. 
 

➢ To change the speed: 

i. Select speed from the dropdown list 
 

ii. Select asset(s) from the Assets list 
 

iii. Click on “Upload” on Quick Speed tab 
 
 
 
 
 

 
 
 
 

 
iv. The user will be prompted as follows: 

 
  

 

 

 

 

 

Step i 

Step iii 

Step ii 
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v. Click on OK to upload speed to the selected asset(s). The job will appear in Job Queue. 
Click on Cancel button to cancel uploading. 
 

 
 
On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 

Success:              Failed: 
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10. Radar 

Any Bartco VMS asset can become a speed advisory sign provided the asset is fitted with a Radar. 
 
The Radar can be programmed in two ways depending on the requirement: 

- Option 1: Display the detected speed only 
The asset typically stays in off mode and starts displaying the speed of the vehicle upon 
detection then go to sleep again. On top of detecting the speed of the approaching 
vehicle, the user can also set up an advisory message if the road user is going above the 
specified speed limit or below the speed limit. 
 

- Option 2: Interrupt displayed message 
Instead of going to sleep/off the asset can show a standard message or speed limit 
message when no vehicle is present. In this instance, the standard message needs to be 
uploaded to the asset separately to the radar file. 

 
The Radar feature is accessible under the “Tools” menu: 

 
 

Radar feature will be displayed as follows: 

 
 

 

 
Setup radar logs to 

be emailed daily 

Download radar 
logs manually 

Disable radar 
on asset 

Upload radar 
config to asset 

Option 1 

Option 2 
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Two actions can be executed on the asset after the radar detects approaching vehicle. 
 
The first action on the asset can be set to any of the following: 

 
 

i. Speed 
Asset shows the detected vehicle speed only, it can be shown in 2 different formats. 
Example: speed can be shown as 70 km/h or just 70 (tick Large checkbox for this) 

 
ii. Radar High/Low 

In this option the user can upload 2 files (Such as “TOO FAST” for speeding and THANK YOU 
for doing below the speed limit) that can advise the speeding vehicle that they are doing 
over the speed limit or doing below the speed limit without showing the vehicle speed.  

 
iii. Radar High 

In this option the user can only upload 1 file that can advise the speeding vehicle if the 
vehicle is approaching above the speed limit to say SLOW DOWN or TOO FAST. If the vehicle 
is doing below the speed limit, then the asset will not respond to them. 

 
iv. Radar Low 

In this option the user can only upload 1 file that can advise the speeding vehicle if the 
vehicle is approaching below the speed limit to say THANK YOU. If the vehicle is doing above 
the speed limit, then the asset will not respond to them. 

 
The second action on the asset can be set as follows: 
 
If the first action of the asset is to show the vehicle speed and follow it up with advisory message, 
then the user needs to select SPEED option in the first option and RADAR HIGH/LOW in second 
option. 

 
Note: The files such as TOO FAST, SLOW DOWN or THANK YOU needs to be prepared first as 
described in section 7. Create Message and save the files as described in section 8.1 Save File 
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The so-called over speed and under speed threshold can be set up at the “Posted Speed Zone” 
Minimum and maximum detection speed limits can also be setup on the asset to prevent it to be 
abused. 
 
Note: the asset will not respond if the detected speed of the approaching vehicle is outside of the 
minimum and maximum detection range. However, the logs will record the speed of every vehicle. 
 

 
 

The user can also schedule a radar that can turn on/off at certain times of the day. Radar default file 
can be used if a message needs to be displayed on the asset during the scheduled radar times.  
 
Note: Radar default file will only work if the radar file is scheduled. For example, see section 12.2 
Schedule a radar file. 
 
 

 
 

 

Enable data logging to record detected speed of the vehicle with a timestamp. Radar logs can be 
downloaded manually or set up to be emailed daily. 
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➢ Upload radar to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: Radar files are saved as different file types than standard files. You may wish to have a 
separate folder for your radar config. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the Radar tab 
Radar config that is open in the Radar tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 
On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:        Failed: 
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11. SMS & Security 

Your asset is equipped with security and operational features which means the asset can send an 
SMS to the operator/s if the unit is tampered with, stolen or if there are any voltage issues. 
 

From the Tools menu select SMS: 

 
 

 

The following SMS options can be set: 
 
 
 
 

 
 

 
 
 
 
 

Various 
alarms to be 
set on asset 

Set mobile numbers 
to which SMS is 

sent by asset 

Reporting 
interval for 

alarms 

Upload SMS 
config file to 

asset 
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Select your options as required, following are suggested settings: 
- Over voltage: recommended at 14.5 V 
- Under voltage: recommended at 11.0 V 
- Over Temperature: usually not required 
- GPS movement: recommended at 1000 m  

Note: Ensure that you either upload this option after the asset has been deployed to its 
desired location or the asset is set to sleep prior to moving. 

- Tamper Enabled: Anti tamper wire where it is fitted 
 
After your options are selected, input up to 3 mobile phone numbers that will be alerted if any of the 
alerts are activated. 

 
 
To remove SMS settings simply uncheck all the boxes and upload file to the asset.  
 
We suggest saving your active and inactive SMS settings in separate folders for consistency and 
future use. 
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➢ Upload SMS config to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: SMS files are saved as different file types than standard files. You may wish to have a 
separate folder for your SMS config. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the SMS & Security tab 
SMS config that is open in the SMS & Security tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 

 
 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:        Failed:     
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12. Scheduler 

Your VMS comes standard with a GPS module which allows the VMS to keep time as well as the 
ability to schedule messages as required, instead of uploading messages each time. 
 
Perfect for Roadworks applications where there may be a pre-warning message, and a message to 
be displayed once the Roadworks begin. 
 
 

12.1 Create Schedule 

To Schedule a file, the desired messages need to be created first as described in section 7. Create 
Message and save those messages as described in section 8.1 Save Message 
 
The Scheduler feature is accessible under the “Tools” menu: 

 
 

Scheduler feature will be displayed as follows: 
 

 

 

 

 

 
 

 

 

 

 

 

 
 

Default file: the default file is displayed when the other scheduled messages are not operating. If no 
default message is selected, then the asset will be blanked when the other scheduled messages are 
not operating. 
 
 

 

 

 

 

Default file: this message is 
displayed when other scheduled 

messages are not operating 

List of 
scheduled 
messages 

Prepare 
message to 

be scheduled 

Upload schedule 
to asset 
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➢ Select a default file: 
 

i. Click on Default File button 
 

ii. Select a file from File Dialog and click Open 

 
 

 

iii. Default file will be selected, and its preview displayed as below: 
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➢ Schedule a message: 

i. Click on “Add Message” button 
 

 
 
 
 
 
 
 

ii. Click on “Select File” button 
 

iii. Select a file from File Dialog and click Open 

 
 

Reset: reset all 
values to 
default 

Close: close this 
configuration 

section 

Insert: 
schedule a 

file 
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iv. A file will be selected, and its preview displayed as below. 
Other options will now be enabled 

 
 

v. Set date and time for the selected message to run as part of schedule 

 
 

vi. Click on “Insert” button to add this message to the list 

 
 
The message R-ahead will now run from 01/12/2021 to 10/12/2021 from 9am to 6pm every day. 
Outside these times, the default message will be displayed. 
 

Note: If the Continuous box is checked then the message will run from 9am on 01/12/2021 until 6pm 
on 10/12/2021 as a continuously running message. 
 

If you would like any other messages to be scheduled simply repeat the process above. 
 
 
 
 
 
 
 

Click on the calendar 
and clock icons to 

change select date and 
time 
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➢ Upload schedule to asset 

i. Save file if required for later use as described in section 8.1 Save File 
Note: Scheduled files are saved as different file types than standard files. You may wish to 
have a separate folder for your schedules. 
 

ii. Select asset(s) in Assets list 
 

iii. Click on Upload button  at bottom of the Scheduler tab 
Schedule that is open in the Scheduler tab will be uploaded to the selected asset. 

 
iv. The user will be prompted as follows: 

 
 

v. Click on YES to upload file to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 
 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 
 
Success:            Failed: 
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12.2 Schedule a radar file 

Example of scheduling a radar file: 
 
A VMS asset is placed in school zone that normally shows the speed limit 60 and changes the speed 
limit to 40 between 8:00am to 9:30am with radar that shows “SLOW DOWN” if the vehicle goes over 
the speed limit of 40. 
 
In this case the radar file will be created with the following: 

 
   
Once the radar file is ready then the schedule will be prepared with the current radar file between 
8:00am to 9:30am with a default file that shows the speed limit 60. 
 

 

  



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 45 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

13. File Manager 

Multiple messages or options to your asset can be uploaded directly from File Manager 
 

 
 

 

 

File Manager displays list of files and folders. 
 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 

Rename selected 
file or folder 

Delete selected 
file or folder 

File’s 
details 

Rename: rename 
file or folder 

Delete: delete file or 
folder 

Create New 
Folder 

Open file or 
folder 

Upload multiple 
files 

v v 

v v v v v 

v 
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13.1 Upload multiple files 

i. Click on Upload Files 
The following dialog will be displayed: 

 
 

ii. Click on Add File and select type of file (Standard, Radar, etc.) or function (Blank sign, etc.) 
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iii. For type of file, select file(s) from file dialog 
Select a file and click on “Select File” button 

 
 

iv. Once all the files have been listed, select asset(s) in Assets list and click on “Upload” button 

 
 

v. The user will be prompted as follows: 

 
 

 

 

 

v 

v 
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vi. Click on YES to upload files to the selected asset(s). The job will appear in Job Queue. 
Click on NO to cancel uploading. 
 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 

 
Success:              Failed: 
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14. Hire Management 

A significant feature of Bartco’s Web Studio is for hire companies or other general users to be able to 
provide their own customer or user with a login and access to asset(s). 
 
Customers can be given access to the system for a determined period, relative to their hire period. 
Once the customer has finished their hire, they do not have access to the asset again. The hire user 
uses their username and password to login to Web Studio. 
 
The Hire Management feature is accessible under the “Tools” menu: 

 
 

 

 

Hire Management feature will be displayed as follows: 
 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

  

Customers: create, 
edit, and delete 
hire customers 

Assets: assign or 
unassign assets that 
hire users can access 

Notes: add notes for 
hire customer that 

is only visible to you 

Users: hire users 
that can access 
assigned assets 
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14.1 Customers 

Shows list of all hire customers. The hired assets and hire users’ account are only accessible during 
valid hire duration (begin and expiry dates). 
 
 

 
 
 
 
  

Reload, Add, Edit and 
Delete Customer 

 Hire duration is active  

 Hire duration is inactive 
 

 

Search customer 

Cross hired customer 

Customer name 
Hire start and  

end dates 
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14.1.1 Cross Hiring  

Cross hire assets to other companies who already have VMS Web Studio account. No need to create 
hire users for such customers. 
 
 

14.1.1.1 Permission to hire assets 
 
You can allow or prevent other company to hire your assets: 

• Tick “Allow Hiring Assets” checkbox to allow customer to hire your assets to others 

• Untick “Allow Hiring Assets” checkbox to prevent customer from hiring your assets to others 

 
 

Cross hired assets with no permission to hire asset is shown as below: 

• Asset’s status icon: 

   
 

• Hire Management - Available Assets: 
Cannot hire assets with “No permission to hire” 

  
 

 

 

  



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 52 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

14.1.1.2 Cross hire assets from another company 
 
To cross hire assets from another company provide them with your company's unique code.  
 

➢ To get your unique code: 

i. Click on "Accounts" menu and click on "Unique Code" submenu 

 
 

ii. Your company’s unique code will be displayed: 

 
 

iii. Copy the unique code by clicking on  button 
 

iv. Securely send the unique code to the company you are hiring assets from 
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14.1.2 Create Hire Customer 

i. Select Add Customer   

 
 

ii. Add hire customer form will be displayed: 

 
 

iii. Cross hire assets 
Skip this step if not cross hiring assets 
 

a. Tick “Cross Hiring” checkbox 

 
 

b. The unique code of company you are cross hiring assets to 

  
 
 
 

c. Allow customer to hire your assets to other users 
YES: tick checkbox 
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NO: untick checkbox 

 
 

iv. Add name of the hire customer  

 
 

v. Add begin date and expiry date 

 
 

vi. Click OK 
 

vii. New hire customer will be added in the list of Customers: 
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14.2 Hire Users 

After the hire customer has been added, create new hire user(s) to the hire customer. 
Skip this step when cross hiring assets. 
 
Note: For security purposes it is a good idea for each user to have their own username and 
password. 
 
The hire user will be responsible for what is displayed on the asset under their login. 
Hire users can only access their account during valid hire duration - begin and expiry dates of 
Customer. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Unlock hire 
user’s account 

Request reset 
password of hire 

user’s account 

Edit details or 
permissions of 

selected hire user 

Delete selected 
hire user 

Add new  
hire user 

Form to add 
or update  
hire user 
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14.2.1 Create Hire User  

i. Click Add Hire User 

 
 

ii. Enter username, email and phone number in the hire user form along with appropriate 
permissions. 

 
 

iii. Click Add Hire User 
 

iv. The new hire user will be added in the Hire Users list 

 
 

 

 

 

 

 

 

 

 

 

 
  

Create and modify files 

Upload files and settings 
to assets 

 

Allow hire user to access 
Program History of asset 

 

Allow hire user to access 
Log Settings 



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 57 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

14.3 Assets 

Hire assets to selected hire customer. The hired assets are only accessible by the users of selected 
hire customer during valid hire duration. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

List of available 
assets to hire 

List of hired assets to 
selected customer 

Remove assets 
from hire in 
Hired Assets 

Hire assets from 
Available Assets 
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14.3.1 Hire Asset to Customer 

i. Select Hire Customer from the list 
 

ii. Go to Assets tab 

 
 

iii. Select asset(s) to hire from Available Assets: 

 

iv. Use  button to hire assets from Available Assets: 

 
 

v. Use  button to remove assets from hire in Hired Assets:   

 
 
 
 



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 59 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

vi. Asset gets listed in Hired Assets to indicate the hire customer has access to it: 

 
 

vii. When the asset is on hire, it will be displayed on the Asset’s status icons: 

 
 

 Asset is currently on hire to HIRE-CUSTOMER-NAME 

 Asset is hired to HIRE-CUSTOMER-NAME and hire duration is inactive 

 Asset is available to hire 

 No permission to hire asset 
 
 
 
 

14.4 Notes 

Save notes for each hire customer. These notes are only visible to users of your company. 
 

 

  

Write internal 
notes 

Save internal 
notes 
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15. Other Settings 

Other Settings contains various special settings for assets. 
 
The Other Settings feature is accessible under the “Tools” menu: 

 
 

Other Settings feature will be displayed as follows: 

 
 

Set Global 
on/off times on 

asset 

Set time zone 
on asset 

Change 
password for 

SMS commands 
on asset 

Set luminance 
settings on asset 
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15.1 Global On / Off Times 

Global on/off times on an asset when enabled displays message only between on and off times. The 
display would remain off during all other times. 
 

15.1.1 Activate global on/off times 

i. Tick “Active On/Off Times” checkbox to enable global on/off times 
 

ii. Select On time  
 

iii. Select Off time 
 

iv. Select asset(s) from Assets list 
 

v. Click Upload to upload settings to asset(s) 

 
 

vi. Asset’s status shows new global on/off times: 

 
 
 
 

15.1.2 Deactivate global on/off times 

i. Untick “Active On/Off Times” checkbox to disable global on/off times 
 

ii. Select asset(s) from Assets list 
 

iii. Click Upload to upload settings to asset(s) 

 

Step i 

Step v 

Step ii 

Step iii 

Step i 

Step iii 
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v. Asset’s status shows global on/off times as disabled: 

 
 

 
 

15.2 Time Zone Settings 

Set time zone on an asset to run schedule and record radar logs in local time.  
Select from Australian state or countries to prefill time zone and daylight savings date (if applicable). 

 
 

➢ To set time zone on asset: 
 

i. Select from Australian state or country 

 
 

ii. Change time zone and daylight savings only if required 
 

iii. Select asset(s) from Assets list 
 

iv. Click Upload to upload settings to asset(s) 
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v. Asset’s status shows new time zone 

 
 
 
 
 

15.3 Change SMS Password 

Sending SMS commands requires password. Use this setting to change password for SMS commands 
on asset. 
Note: this feature is only available on request 
 

 
 

➢ To change SMS password: 
 

i. Set Old Password and New Password 
 

ii. Select asset(s) from Assets list 
 

iii. Click Upload to upload settings to asset(s) 
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15.4 Luminance Settings 

Set luminance/brightness on asset to automatic mode or manual mode. 

 
 

➢ To set luminance on asset: 
 

i. Select luminance from dropdown 
- Use Auto for automatic mode 
- Use Level 1 to 6 for manual mode 

 
 

ii. Select asset(s) from Assets list 
 

iii. Click Upload to upload settings to asset(s) 
 

iv. Asset’s status shows new Luminance 
 
Automatic mode:   Manual mode at level 1: 
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16. Administration 

This tab is only available if user has permission to access it. 
 
The Administration feature is accessible under the “Tools” menu: 

  
 
 
 

16.1 Users 

Manage existing users or create new users using this tab. 
Note: For security purposes it is a good idea for each user to have their own user account. 
 
Users will be displayed as follows: 
 
 
 
 

 
 
 
 
 
 
 
 

  

List of users 
and their 

permissions 

Create and 
delete users 

Perform action 
on users 

Download 
list of users 

Open user 
manual 

Update user’s 
details 
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16.1.1 Create User 

v. Click Add User 

 
 

vi. Enter username, email and phone number in the user form along with appropriate 
permissions. 

 
 

vii. Click Add user 
 

viii. The new user will be added in the Users list 

 
 

  

Access Administration 
feature 

Access Hire 
Management and Log 

Settings features 

Upload files and 
settings to assets 

Create and modify 
files 

Upgrade firmware to 
latest version on asset 
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16.1.2 Unlock Account 

User account gets locked temporarily due to incorrect login attempts. Users with Administration tab 
can unlock those temporarily locked user accounts. 
 

 
 
 
 

 

➢ To unlock user account: 

i. Click Action -> Unlock Account 

 
 

ii. The user will be prompted as follows: 

 
 

iii. Result will be displayed as follows: 

 
 

iv. “service” user account has been unlocked and the user will then be able to login again 
 

 

  

User account locked 



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 68 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

16.1.3 Reset Password 

Reset user’s password – same as “Forgot your password” on login page 
 

➢ To reset password: 

i. Click Action -> Reset Password 

 
 

ii. The user will be prompted as follows: 

 
 

iii. Result will be displayed as follows: 
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16.2 Assets  

Assets tab lists all your assets in easily accessible table format. Get an overview of 3G/4G assets 
and manage various fields of an asset. 
 
Assets will be displayed as follows: 
 
 
 
 

 
 
 
 

 
 
 

  

Download 
list of assets 

Update asset 
information 

List of assets 
with important 
fields and alerts 
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16.2.1 Update Asset Details 

i. Select an asset from Assets grid 
 

ii. Double click on selected asset or click Edit asset button 

 
 

iii. Update asset’s Label, Client Reference and Radar Fitted fields 

 
 
 
 
 
 
 
 
 

Update asset’s fields 
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iv. Request Bartco’s service team to update Company, Asset Type, VIN, Registration, 

Modem Gen and Web Studio fields of an asset 

 
 

  

Request Bartco’s service team to 
update information of an asset 
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16.2.2 Upgrade Firmware 

“Upgrade Firmware” button is only available when new firmware is available to upgrade  
 

 Firmware critically out of date (warning) 

 New firmware available to upgrade 

 Firmware upgrade is in progress 

 Latest firmware installed 
 
 

  
 

 
To upgrade firmware on asset: 

 
i. Click on Upgrade Firmware in Administration – Assets tab or right click on the asset in Assets list 

 
ii. The user will be prompted as follows: 

 
 

iii. Click on OK to start firmware upgrade process on the selected asset(s). The job will appear in Job 
Queue. 
Click on Cancel button to cancel firmware upgrade. 

 

Firmware details 
of the asset 

 



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 73 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

 

iv. The asset’s status icon will change to  

 
 

v. Firmware upgrade takes about 60 to 120 minutes to complete. 
On completion, the result will be displayed in the Information panel at the bottom of the page. 

 
Success:             Failed: 

           
 

  



 

Phone: 1300 306 106  
Email:  service@bartco.com.au    Page 74 of 79 
 

VMS WEB STUDIO® User Manual v4.8.0 

17. Special assets  

17.1 Electronic Fire Danger Rating Signs (Fire Signs) 

Bartco’s Electronic Fire Danger Rating signs (fire signs) are programmed with a fire rating and 
corresponding message as below: 

Fire Rating Message 

No Rating NO RATING 

Moderate PLAN AND PREPARE 

High BE READY TO ACT 

Extreme TAKE ACTION NOW 

Catastrophic LEAVE BUSHFIRE AREA 

 

17.1.1 Fire sign – 4 ratings 

The following table shows fire rating with its message on the new 4 ratings fire sign: 
 

Fire Rating Message (frame 1) 
(00-00-0000 replaced with date dd-mm-yyyy) 

No Rating 

 
 

Moderate 

 
 

High 

 
 

Extreme 

 
 

Catastrophic 
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17.1.2 Fire sign – retrofitted 

The following table shows fire rating with its message on retrofitted fire sign: 
 

Fire Rating Message (frame 1) Message (frame 2) 

No Rating 

 

 

Moderate 

  
High 

  
Extreme 

  
Catastrophic 
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17.1.3 Upload Fire Rating 

To upload fire rating on an asset: 
 

i. Select asset(s) from the Assets list 
 

ii. Right click on selected asset(s) 
Select a rating from the menu “Upload Fire Rating” 

 
 

iii. The user will be prompted as follows: 

 
  

iv. Click on OK to upload fire rating on the selected asset(s). The job will appear in Job Queue. 
Click on Cancel button to cancel uploading. 

 
 

On completion, the result will be displayed in the Information panel at the bottom of the 
page. 
 
Success:      Failed: 
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17.1.4 Asset Status – special fields 

Special fields in Asset’s status: 

FDR Fire Danger Rating being displayed on the fire sign: 
- No Rating 
- Moderate 
- High 
- Extreme 
- Catastrophic 

 
 
 
 
 
 
 
 

17.2 VSLS 

17.2.1 Upload Speed 

Use Quick Speed to upload speed to a VSLS 
 
 

17.2.2 Asset Status – special fields 

Special fields in Asset’s status: 

Annulus Flashing Annulus Flashing state of VSLS 
- Synchronized 
- Unsynchronized 
- Unknown (unsupported firmware version) 
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17.3 Traffic Lights 

17.3.1 Asset Status – special fields 

Special fields in Asset’s status: 

Control Type Control type selected: 
- One Way Mode 
- Two Way Mode 

Operation Mode Operation mode selected: 
- POWER OFF 
- AUTO 
- MANUAL 
- SENSOR 
- FLASH YELLOW 
- FLASH YELLOW ON FAULTY 
- MAINTENANCE 

Fault Fault reported 

Is Master YES if this Traffic Light is a master otherwise NO 

Radio Network Radio network 

 
 
Special fields in Asset’s status for Master only: 

Remote Controllers List of Radio Remote controllers connected to master 

Phase Time Various phase time of Master and slave(s) in format: 
Red : Yellow : Max Green : Extend Green 

Slave Info Slave’s controller serial number 
Additional information about all the slaves connected to master 

Radio RSSI Slave’s RSSI 

Battery Slave’s battery 
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18. Troubleshooting 

• No Communication 
When the asset doesn’t communicate on Web Studio with the following error: 

      
 

POSSIBLE CAUSE POSSIBLE SOLUTION 

Asset out of mobile phone coverage  Move asset to better coverage 

Sim card not inserted properly  Check sim card orientation 
(Reset power after re-positioning sim) 

Modem Failure  Contact Bartco 

Electrical Check fuses and battery level 

 
 

• Daylight Savings change 
o Verify time zone on assets to ensure accurate operation of Schedule, Radar, etc. 

 
 

o Upload time zone settings to an asset as described in section 15.2 Time Zone 
Settings 

 
 
Please contact Bartco’s technical support on 1300 306 106 or service@bartco.com.au for any 
technical assistance. 

mailto:service@bartco.com.au

